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1 Introduction

1.1 Document Purpose

TRED is an interactive Java software engineering environment exploiting the state-of-the-art technology in incremental graph presentation and layout.  This document defines a software implementation which fulfills the requirements laid out in the Use Case Model and other documents.  Because of this, it is to be used as the framework for the software design of the TRED application.
1.2 Document Scope

The targeted user of this document is developers tasked with developing the TRED application software.  While it does describe the functionality of the system on a technical level, it is not intended to be used by the User in place of a non-technical User Manual.  In addition, this document can be used by the customer (Dr. Workman at the University of Central Florida) as a means of evaluating the final software implementation of the TRED application.
1.3 Definitions, Acronyms, and Abbreviations

	Contextual Menu
	A pop up menu activated by the right-click of a mouse over a node.  It provides a selection of available operations that can be performed based on that node type.

	GRXL
	A XML based file format used to store trees and graphs.  Documented in the FileFormats-Graphs.doc file supplied by the Customer.

	Java
	An Object Oriented programming language created by Sun Microsystems with the intent of being very portable.

	Program Element (Element/Node)
	An individual Java code element that is stored in the Tree.  Each program element maps directly to one or more actual Java code statements.  Possible types are: Program Node, Package Node, Class Node, Data Members Node, and Method Nodes.

	SDK
	Software Development Kit.  A tool used for developing software of some form.

	Shape Layout (Shape Algebra)
	The algorithms which define the positioning and organization of the Tree and its Nodes.

	TRED
	The application which is being defined by this document.  It will allow the user to generate a Java code design in the form of a Tree and export it out into actual compilable Java code.

	Program 

(Tree)
	The hierarchy of program elements that comprises a valid Java program.  The base of a complete Program is a Program Node which identifies the program being created.

	View
	A child window inside of the main application window.  Each view contains exactly 1 tree.

	XML
	Short for eXtensible Markup Language.  It’s a language used for storing and communicating data across in a structured format.


1.4 References

 [1] TRee EDitor (TRED) Use Case Model, 17 March 2005, Hathaway, D., Griffin, J., Shade, R., Young, M.

[2] IEEE Recommened Practice for Software Requirements Specifications, IEEE Std 830-1998, 25 June 1998, IEEE-SA Standards Board

[3] An Incremental Tree Editor for Dynamic Hierarchical Drawing of Trees, 20 January 2004, Workman, D., Bernard, M., and Pothoven, S.

[4] Graph File Formats, Supplied by Dr. Workman in the file called FileFormats-Graphs.doc
1.5 Document Overview

The TRED applications software description follows.  Section 2 covers higher-level requirements and interfaces to the application.  Section 3 goes into more detail about the lower-level design and software architecture.  It further defines how the architecture meets the requirements of the system laid out in the Use Case Model.

2 Overview and Summary of the Simulation System

2.1 Project Motivation and Business Analysis

There are currently very few CASE (Computer Aided Software Engineering) tools that allow developers to manipulate and analyze design as well as produce actual code.  Tools of this nature are very useful because they enable developers to quickly and seamlessly step from the design process into implementation and test activities within the same development frame work; software engineers do not have to switch between tools produced by different vendors when they go from design to code and unit test.   The goal of this project is to develop a prototype Java software engineering environment supporting both design and implementation activities through a user-friendly graphical interface.

The development of effective CASE tools is complicated by, and depends heavily on, the choice of target implementation language(s) they support. For example, languages such as C/C++ have so much variation in syntactic and semantic features and provide so much flexibility in program organization and structure, that it becomes extremely difficult to design a CASE tool capable of efficient and effective pre-code program analysis.  Java, on the other hand, yields more readily to automated pre-code program analysis because of the structural and semantic restrictions it imposes; e.g., no gotos and no pointer arithmetic.  


Because of Java’s clean structure and semantics, complete programs can be represented completely in the form of trees.  That is, program building blocks and features have an inherently hierarchical relationship to one another.  Not only does Java fully support the object-oriented paradigm as a program design style, the structure of language itself can be described in terms of OO concepts.  Figure 1-1 illustrates the complete structure of a Java program expressed in the form of a UML (Unified Modeling Language) Class diagram.

Note that the structure is completely hierarchical (tree-formed) such that the first three structural levels can be viewed as the architectural design levels, the fourth and fifth levels as detailed design levels, and any levels beyond as purely implementation levels.  Being able to define and edit the programs structure at any level within the same tool offers tremendous power and convenience to the Java program developer.
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Figure 1‑1 Example Java Program Tree

TRED is designed to allow users to develop Java programs by designing a tree structure that defines the program to be generated.  Each tree, in its entirety, creates a Java program that is both correct and can be compiled.  In addition, TRED provides tools that easily allow users to create components and link them together using the tree structure.  The Program Node of the tree simple identifies the Program you are designing (and will be generating).  Other node types that can be added to the Program Node include a Package Node and a Class Node.  Each Class Node can then include nothing, a Data Member Node, or multiple Method Nodes.  Refer to Figure 1‑1 Example Java Program Tree. 
Furthermore, to expand the product to meet a wider consumer base, this application is being designed to work on multiple computing platforms.  The goal is to allow TRED to be run on any machine running with the appropriate Java run-time installed and the following operating systems: Microsoft Windows XP (SP1 and SP2), Apple OS X – Panther, and Mandrake Linux 10.0 (32-bit edition).  Further operating systems should be functionally capable, but won’t be testable during this process of development.
2.2 Operational Concept and Functional Capabilities

2.2.1 System Actors and Use Cases

· Use Case Diagram

· Operational Narrative

· System State/Process Model

· External Interfaces

· Functional Requirements

· Non-Functional Requirement
2.2.2 Assumptions and Dependencies
To develop the TRED application, the lead architects have devised a common development environment for all developers to use.  Developers must first be familiar with the Java language and Object Oriented concepts.  This is required due to the fact that the entire TRED project will be written in Java.  In addition, one developer should at least become familiar with the Xerces XML parsing libraries. 
Due to the broad nature of the target environments for the end-user, developers may use any one or more of the following operating systems on their machines.  Preferably, at least one developer will have a machine with each one of the target operating systems.

· Windows XP Service Pack 2

· Mac OS X – Panther
· Mandrake Linux 10.0 32-bit edition for i386 computers

The following applications must be installed on a developer’s machine:

· Java 2 SDK version 1.4.2-06

· Eclipse SDK version 3.0.1

· Xerces Java XML Library binaries version 2.6.2

3 Use Case Specifications

3.1 Load Program

ID: UC1
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Figure 3.1‑1 Load Program Collaboration Diagram

Purpose

The purpose of Load Program use case is to allow the user to Load an existing program from a file system.

Pre-Conditions
None.

Flow of Events

1. User selects the “Open” entry in the “File” menu.

2. The system shows the operating system’s “Open File” dialog.

3. The user selects the file to be opened.

4. User clicks the “Open” button in the dialog.

5. The system loads the XML input file.

6. The system displays the opened program in a new view.

7. The new view is made the active view.

Alternate Paths
1a. User clicks in any area other than the menu.

8. The use case terminates.

4a. The user has not selected a file.

9. The system presents the user with an error dialog stating that the user must select a file.

10. The user dismisses the dialog.

11. Use case returns to step 3.

4b. The user clicks the “Cancel” button in the dialog.

12. The user case terminates.

5b. The file selected was in an invalid format.

13. The system presents the user with an error dialog stating that the file was in an invalid format.

14. The user dismisses the dialog.

15. The use case terminates.

Post Conditions
If a valid file was chosen, the system is focused on the new view.  Else, the system follows an alternate path to use case termination and the system returns to the initial state before the use case.

3.2 Create New Program

ID: UC2
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Figure 3.2‑1 New Program Collaboration Diagram

Purpose

The purpose of the Create New Program use case is to allow the Editor User to create a new program.
Pre-Conditions
None.

Flow of Events

16. The user selects “New” entry in the “File” menu.

17. The system displays a new empty view composing of a root program element which can have other program elements added onto it.
Alternate Paths
1a. User clicks in any area other than the menu.

18. The use case terminates.

Post Conditions
If the use case completes successfully, the system is focused on a new, empty view.  Else, the system returns to the initial state before the use case.

3.3 Select View

ID: UC3
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Figure 3.3‑1 Select View Collaboration Diagram

Purpose

The purpose of the Select View use case is to allow the Editor User to select the active View.
Pre-Conditions
At least 1 view is active.

Flow of Events

19. The user clicks somewhere in the area of an existing View.

20. The system sets the View as the currently selected View.
Alternate Paths
1a. User clicks in any area other than a View.

21. The use case terminates.

1b. User clicks in the currently selected View

22. The use case terminates

Post Conditions
If the use case completes successfully, the system is focused on the selected view.  Else, the system returns to the initial state before the use case.

3.4 Close Program

ID: UC4
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Figure 3.4‑1 Close Program Collaboration Diagram

Purpose

The purpose of the Close Program use case is to allow the Editor User to close an existing Program.
Pre-Conditions
At least 1 view is active.

Flow of Events

23. The user selects “Close” entry in the “File” menu.

24. The system closes the currently selected Program.
Alternate Paths
1a. User clicks in any area other than a View.

25. The use case terminates.

1b. User clicks on the X square in the upper right of the Window View border.

26. The View whose border square was clicked is selected as the currently selected Tree View.

27. Proceeds to step 2 of this Use-Case.

Post Conditions
If the use case completes successfully, the system closes the selected view.  Else, the system returns to the initial state before the use case.

3.5 Cut Program Element
ID: UC5
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Figure 3.5‑1 Cut Program Element Collaboration Diagram

Purpose

The purpose of Cut Program Element is to allow the user to remove a portion of the active program and place it on the clipboard.

Pre-Conditions
1. A view is being displayed with a program with at least one program element.

Flow of Events

28. The user right-clicks over a node in a view.

29. The system presents the user with a contextual menu.

30. The user selects the “Cut” entry in the contextual menu.

31. The view is updated reflecting the removal of the Sub-Tree.

32. The Sub-Tree is placed on the Clipboard as the most active item.

Alternate Paths
1a. The user selects “Cut” from the "Edit” menu continues at Step 4.
3a. The user clicks over any area other than a selection in the contextual menu.

33. The use case terminates.

Post Conditions
1. The active tree view reflects the sub-tree removal. 

2. The program element removed is added to the clipboard as the most recent item.

3.6 Copy Program Element
ID: UC6
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Figure 3.6‑1 Copy Program Element Collaboration Diagram

Purpose

The purpose of Copy Program Element is to allow the user to copy a group of program elements to the clipboard.  
Pre-Conditions
1. A view is being displayed with a program with at least one program element.

Flow of Events

34. The user right-clicks over a program element in a view.

35. The system presents the user with a contextual menu.

36. The user selects the “Copy” entry in the contextual menu.

37. The Program Element is placed on the Clipboard as the most active item.

Alternate Paths
1a. The user selects “Copy” from the "Edit” menu continues at Step 4.
3a. The user right-clicks over any area other than a selection in the contextual menu.

38. The use case terminates.

Post Conditions
If the use case was completed successfully, a copy of the program element and it’s sub-elements is placed on the clipboard as the most recent item.  Else, the use case terminates and the system returns to the initial state before the use case.

3.7 Delete Program Element
ID: UC7
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Figure 3.7‑1 Delete Program Element Collaboration Diagram

Purpose

The purpose of Delete Program Element is to allow the user to remove a Program Element and it’s sub-elements from the active program view.
Pre-Conditions
1. A view is being displayed with a program with at least one program element.

Flow of Events

39. The user right-clicks over a node in a view.

40. The system presents the user with a contextual menu.

41. The user selects the “Cut” entry in the contextual menu.

42. The view is updated reflecting the removal of the Sub-Tree.

Alternate Paths
1a. The user selects “Cut” from the "Edit” menu continues at Step 4.
3a. The user right-clicks over any area other than a selection in the contextual menu.

43. The use case terminates.

Post Conditions
If the use case was completed successfully, the tree is updated to reflect the removal of the program element.  Else, the use case terminates and the system returns to the initial state before the use case.

3.8 Insert New Program Element
ID: UC8
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Figure 3.8‑1 Insert Program Element Collaboration Diagram

Purpose

The purpose of Insert Program Element is to allow the user to add a program element to an existing program.

Pre-Conditions
1 A view is being displayed.

Flow of Events

44. The user right-clicks on the view.

45. The system presents the user with a contextual menu.

46. The user selects the “Insert Node” entry in the contextual menu.

47. The system presents the user with the “Insert Node” dialog.

48. The user selects the characteristics for the node to be inserted.

49. The user clicks the “Insert” button in the dialog.

50. The view displays the inserted node.

Alternate Paths
1a. The user selects “Insert Node” from the "Edit” menu continues Step 4.
2a. The tree contains nodes and the user did not right-click over a node.

51. The “Insert Node” entry is disabled.

52. The use case terminates.

2b. The tree contains nodes and the user right-clicked over one of them.

53. The new node will be added as a child of the existing node.

54. The use case continues at Step 3.

3a. The user clicks in any area other than the contextual menu.

55. The use case terminates.

6a. The user clicks the “Cancel” button in the dialog.

56. The node is not inserted and the use case terminates.

6b. The user clicks the “Ok” button but not all data has been filled in correctly.

57. Dialog is displayed indicating that all the fields have not been filled in.

58. Use case returns to step 5.

Post Conditions
If the use case was completed successfully, a new node is added to the tree (with the characteristics selected) at the location specified.  Else, the use case terminates and the system returns to the initial state before the use case.

3.9 Paste Program Element
ID: UC9
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Figure 3.9‑1 Paste Program Element Collaboration Diagram

Purpose

The purpose of Paste Program Element is to allow the user to insert the last Program Element that was previously cut or copied onto the Clipboard into the currently active tree.

Pre-Conditions
59. A view is being displayed.

60. The clipboard is not empty.

Flow of Events

61. The user right-clicks on the view.

62. The system presents the user with a contextual menu.

63. The user selects the “Paste Sub-tree” entry in the contextual menu.

64. The view displays the inserted Sub-Tree.

Alternate Paths
2a. The tree contains nodes and the user did not right-click over a node.

65. The use case terminates.

3a. The user clicks in any area other than the contextual menu.

66. The use case terminates.

4a. A warning is displayed indicating that the selected sub-tree can not be added to the specified area.
67. The use case terminates.

Post Conditions
If the use case was completed successfully, a copy of the most recent item (sub-tree) from the clipboard is inserted into the currently active tree at the location specified.  Else, the use case terminates and the system returns to the initial state before the use case.

3.10 Paste From Clipboard
ID: UC10
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Figure 3.10‑1 Paste From Clipboard Collaboration Diagram

Purpose

The purpose of Paste From Clipboard is to allow the user to insert a Sub-Tree from the clipboard into the currently active tree.

Pre-Conditions
68. A view is being displayed.

69. The clipboard is not empty.

Flow of Events

70. The user right-clicks on the view.

71. The system presents the user with a contextual menu.

72. The user selects the “Paste from clipboard…” entry in the contextual menu.

73. The system presents the user with the “Paste From Clipboard” dialog (Figure 1‑4).

74. The user selects the entry to be inserted.

75. The user clicks the “Insert” button in the dialog.

76. The view displays the inserted Sub-Tree.

Alternate Paths
2a. The tree contains nodes and the user did not right-click over a node.

77. The “Paste from clipboard…” entry is disabled.

78. The use case terminates.

2b. The tree contains nodes and the user right-clicked over one of them.

79. The Sub-Tree will be inserted as a child of the existing node.

80. The use case continues at Step 3.

3a. The user clicks in any area other than the contextual menu.

81. The use case terminates.

6a. The user clicks the “Cancel” button in the dialog.

82. The node is not inserted and the use case terminates.

6b. A warning is displayed indicating that the selected sub-tree can not be added to the specified area.  Proceed back to Step 5.
Post Conditions
If the use case was completed successfully, a copy of the most recent item (sub-tree) from the clipboard is inserted into the currently active tree at the location specified.  Else, the use case terminates and the system returns to the initial state before the use case.

3.11 Edit Program Element
ID: UC11
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Figure 3.11‑1 Edit Program Element Collaboration Diagram

Purpose

The purpose of the Edit Program Element use case is to allow the user to perform various editing functions for a node.

Pre-Conditions
A view is being displayed with a program with at least one program element.
Flow of Events

83. The user right-clicks on the node to be edited.

84. The system presents the user with a contextual menu.

85. The user selects the “Edit Node” entry.

86. The system presents the user with the “Edit Node” dialog.

87. The user selects the characteristics to be modified.

88. The user clicks the “Ok” button.

89. The view redisplays the node with the selected characteristics.

Alternate Paths
1a. The user selects “Edit Node” from the "Edit” menu continues Step 4.
3a. The user clicks in any area other than the contextual menu.

90. The use case terminates.

6a. The user clicks the “Cancel” button.

91. No changes to the node are made and the use case terminates.

6b. The user clicks the “Ok” button but not all data has been filled in correctly.

92. Dialog is displayed indicating that all the fields have not been filled in.

93. Use case returns to step 5.

Post Conditions
If the use case was completed successfully, the selected node is updated to reflect the changes made to it in the use case.  Else, the use case terminates and the system returns to the initial state before the use case.

3.12 Save Program
ID: UC12
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Figure 3.12‑1 Save Program Collaboration Diagram

Purpose

The purpose of Save Program use case is to allow the user to save a program to its associated file.
Pre-Conditions
94. A view is being displayed.

Flow of Events

95. The user selects the “Save” entry in the “File” menu.

96. The system writes the tree to the file.

Alternate Paths
1a. The view is not associated with a file.

97. The use case proceeds to Step 2 of the Save Tree As use case.

2a. The storage area runs out of space or is not write-able.

          1. The use case displays a warning dialog.

          2. After user acknowledges warning dialog, the use case proceeds to Step 2 of the Save Program Element As use case.
Post Conditions
If the use case was completed successfully, the active program view is saved to a file.  Else, the use case proceeds to step 2 of the Save Program As use case.

3.13 Save Program As
ID: UC13
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Figure 3.13‑1 Save Program As… Collaboration Diagram

Purpose

The purpose of Save Program As… use case is to save a tree as a graph file in the GRXL file format.  This format is a XML based file format that is used by other tree researchers.  The file will be saved out with the extension “.grxl” appended to the user’s filename choice.

Pre-Conditions
98. A view is being displayed.

Flow of Events

99. The user selects the “Save As…” entry in the “File” menu.

100. The system presents the user with the operating system’s “Save as” dialog.

101. The user selects the file to save to.

102. The user clicks the “Save” button in the dialog.

103. The system writes the program to the file.

Alternate Paths
3a. The user selects an existing file.

          1. A dialog is displayed asking the user if they are sure they want to over-write the file.

          2. User chooses option on dialog:

                      1. Over-write – file is overwritten by new tree file.

                      2. Cancel – file is not overwritten and use case returns to Step 3.

4a. The user has not selected a file.

104. The system presents the user with an error dialog stating the user has not chosen a file to save to.

105. The user dismisses the error dialog.

106. The use case returns to Step 3.

4b. The user clicks the “Cancel” button in the dialog.

107. The file is not saved and the use case terminates.

5a. The storage area runs out of space or is not write-able.

          1. The use case displays a warning dialog.

          2. After user acknowledges warning dialog, the use case returns to Step.
Post Conditions
If the use case was completed successfully, the active tree view is saved to a file with the filename input by the user.  Else, the use case terminates and the system returns to its initial state before the use case.

3.14 Export to Java
ID: UC14
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Figure 3.14‑1 Export to Java Collaboration Diagram

Purpose

The purpose of Export to Java is to allow the user to save a program as a template in Java source code.

Pre-Conditions
108. A view is being displayed.

Flow of Events

109. The user selects the “Export to Java…” entry in the “File” menu.

110. The system presents the user with the operating system’s “Save as” dialog.

111. The user selects the file to save to.

112. The user clicks the “Save” button in the dialog.

113. The system writes the program to the file in Java source form.

Alternate Paths
3a. The user selects an existing file.

          1. A dialog is displayed asking the user if they are sure they want to over-write the file.

          2. User chooses option on dialog:

                      1. Over-write – file is overwritten by new tree file.

                      2. Cancel – file is not overwritten and use case returns to Step 3.

4a. The user has not selected a file.

114. The system presents the user with an error dialog stating the user has not chosen a file to save to.

115. The user dismisses the error dialog.

116. The use case returns to Step 3.

4b. The user clicks the “Cancel” button in the dialog.

117. The file is not saved and the use case terminates.

5a. The storage area runs out of space or is not write-able.

          1. The use case displays a warning dialog.

          2. After user acknowledges warning dialog, the use case returns to Step.
Post Conditions
If the use case was completed successfully, the active tree view is used to generate java source code in the file with the name specified during step 3.  Else, the use case terminates and the system returns to its initial state before the use case.

3.15 Hide Program Element
ID: UC15
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Figure 3.15‑1 Hide Program Element Collaboration Diagram

Purpose

The purpose of Hide Program Element is to allow the user to collapse part of the program to one program element, freeing space in the program view.

Pre-Conditions
118. A view is being displayed.

Flow of Events

119. The user right clicks on a program element with children.

120. The system presents the user with a contextual menu.

121. The user selects “Hide Program Element”.

122. The tree view is updated to reflect the fact that the node’s sub-tree is now hidden.

Alternate Paths
4a. The user clicks in any area other than the contextual menu.

1. The use case terminates.

Post Conditions
If the use case was completed successfully, the active tree view is updated to reflect collapsing the program element and it’s sub-elements.  Else, the use case terminates and the system returns to its initial state before the use case.

3.16 Unhide Program Element
ID: UC16
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Figure 3.16‑1 Unhide Program Element Collaboration Diagram

Purpose

The purpose of Expand Program Element is to allow the user to expand a program element and it’s sub-elements that has been previously collapsed.

Pre-Conditions
123. A view is being displayed.

Flow of Events

124. The user right clicks on a collapsed node.

125. The system presents the user with a contextual menu.

126. The user selects “Expand Program Element”.

127. The program view is updated to reflect an expansion of the program element and its sub-elements.

Alternate Paths
1a. The user clicks in any area other than a collapsed node.

1. The use case terminates

3a. The user clicks in any area other than the contextual menu.

1. The use case terminates.

Post Conditions
If the use case was completed successfully, the active tree view is updated to reflect expanding the node’s sub-tree.  Else, the use case terminates and the system returns to its initial state before the use case.
4 External Interface Specifications

4.1 Input Specifications

The TRED project saves all the Program data in a common tree XML output format.  This format is known as GRXL.  It outputs the data in a format that external applications will be able to generate the program in the exact tree structure.  The external application may not be able to display all of the internal data, but the basic shape and structure will still be the same.  The GRXL format is described in the following XML DTD which should be used when loading the XML parser to parse the data files:

<!ELEMENT grxl (attr*, nodetype*, edgetype*, hostgraph*, transformation*)> 

<!ATTLIST grxl 

  id ID #IMPLIED> 

<!ELEMENT nodetype (attr*)> 

<!ATTLIST nodetype 

  id ID #REQUIRED 

  parent IDREF #IMPLIED 

  shape CDATA #IMPLIED 

  height CDATA #IMPLIED 

  width CDATA #IMPLIED> 

<!ELEMENT edgetype (attr*)> 

<!ATTLIST edgetype 

  id ID #REQUIRED 

  parent IDREF #IMPLIED 

  directed (true | false) "true"> 

<!ELEMENT hostgraph (attr*, node*, edge*)> 

<!ATTLIST hostgraph 

  id ID #REQUIRED> 

<!ELEMENT transformation (attr*, rewrite*)> 

<!ATTLIST transformation 

  id ID #REQUIRED> 

<!ELEMENT rewrite (attr*, lhsgraph, rhsgraph)> 

<!ATTLIST rewrite 

  id ID #REQUIRED> 

<!ELEMENT lhsgraph (attr*, node*, edge*)> 

<!ATTLIST lhsgraph 

  id ID #REQUIRED> 

<!ELEMENT rhsgraph (attr*, node*, edge*)> 

<!ATTLIST rhsgraph 

  id ID #REQUIRED> 

<!ELEMENT node (attr*)> 

<!ATTLIST node 

  id ID #REQUIRED 

  type IDREF #IMPLIED 

  match IDREF #IMPLIED 

  label CDATA #IMPLIED 

  xpos CDATA #IMPLIED 

  ypos CDATA #IMPLIED 

  variable (true | false) "false" 

  negative (true | false) "false"> 

<!ELEMENT edge (attr*)> 

<!ATTLIST edge 

  id ID #REQUIRED 

  type IDREF #IMPLIED 

  match IDREF #IMPLIED 

  begin IDREF #REQUIRED 

  end IDREF #REQUIRED 

  label CDATA #IMPLIED 

  variable (true | false) "false" 

  negative (true | false) "false"> 

<!ELEMENT attr (attrelement)*> 

<!ATTLIST attr 

  name CDATA #REQUIRED 

  value CDATA #IMPLIED> 

<!ELEMENT attrelement EMPTY> 

<!ATTLIST attrelement 

  name CDATA #REQUIRED 

  value CDATA #IMPLIED> 

For more information and an example of the basic file format, refer to Reference [4] under the section titled “GRXL”.
4.2 Output Specifications

The output file format is exactly identical to the input file format.  An additional operation, however, is the ability to export Java Code.  For more information on the format of Java code, refer to the Java 1.4.2 Reference.
4.3 GUI Specifications

The interface to the TRED application is through a Graphical User Interface.  This interface is used to construct the Java Program Tree by adding individual program elements as nodes to a tree.  Due to the fact that we are using the Swing API on Java, the windowing environment will exactly match whatever window settings the user’s operating system is currently using.  Because of this, the exact look and feel of the windowing interface will change slightly based on the Operating system used.  The following screenshots were taken on the Windows XP SP 2 platform.
When first invoking TRED, the user will be shown a multi-view window interface with 0 or more windows open by default.  Figure 4.3-1 below shows the GUI that the user is greeted with upon invoking the TRED application under windows.  
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Figure 4.3‑1 Main GUI interface for TRED
The user can perform many elementary actions through the menu system provided with the GUI.  They can create a new program, load an existing program from a GRXL file, edit the tree data, save a current tree, or export it to Java code.  The following two Figures show both the File menu and Edit menu available in TRED:
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Figure 4.3‑2 TRED File Menu
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Figure 4.3‑3 TRED Edit Menu

In addition, instead of forcing the user to perform all the edit commands from the edit menu, we will add a contextual menu available upon the right click of the mouse over an existing node.  The following Figure demonstrates the Contextual Menu.
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Figure 4.3‑4 TRED Context Menu

Figure 4.3-5 shows the Dialog box allowing a user to add a new node.  This dialog box actually changes based on the type of node a user decides to add.  The node being added in the picture below is a Method node so has 2 additional fields that many other nodes do not have.  These fields are the visibility of the Java Method (inside of the class) and the data type returned by the method.
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Figure 4.3‑5 TRED Add Node Dialog

Figure 4.3-6 shows the Dialog box allowing a user to edit an existing node.  This dialog box also changes based on the type of node a user decides to add.  The node being edited in the picture below is a Class node so has 1 additional fields that many other nodes do not have, the visibility field.
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Figure 4.3‑6 TRED Edit Node Dialog

When the user clicks Save or Save As under the File menu, they are presented with a Save file dialog box.  Figure 4.3-7 shows the dialog box displayed.
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Figure 4.3‑7 Save Program Tree Dialog

Figure 4.3-8 shows the Load Program dialog box invoked when the user chooses Load from the File menu.
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Figure 4.3‑8 Load Program Tree Dialog

Figure 4.3-9 shows the Export to Java dialog box invoked when the user chooses Export from the File menu.
[image: image26.png]Export: to Java.

My Recert
Documerts.

=]
)

My Computer

?

My Network
Places

File name:

Fils oftype:

alFles





Figure 4.3‑9 Export to Java Dialog

5 Internal Software Specifications

5.1 Architectural Overview
We’ve broken the TRED application down to 5 unique components.  Each component focuses on a specific task.  Figure 5.1-1 illustrates the relationship of the components with each other.
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Figure 5.1‑1 Component Architecture of the TRED system

The GUI Component is responsible with providing the Graphical User Interface (GUI) through which the user interacts with the TRED application.  The GUI is created using the Swing Java library so that it looks similar to existing windows on the user’s desktop.

The Tree Algorithm Component consists of all classes which control how a tree is structured, shaped, and copied.  It is the class that the GUI Component most interacts with.  In addition, it defines how the GUI Component displays the trees defined inside of the classes.
The Clipboard Component is responsible with providing a mechanism by which users can copy and paste sub-trees between nodes.  This functionality has also been modified to allow users to be able to select exactly which sub-tree in the history of the clipboard will be added during the pasting operation.  This is very similar to how word processor clipboards work today.  It interfaces only with the GUI Component.
The Java Exporter Component is composed of all classes and packages responsible with exporting a valid tree into Java Program Code.  It interfaces with both the GUI Component as well as the Tree Algorithm Component.
The XML File Component is responsible with loading and saving the intermediate GRXL XML files which contain the tree data.  The classes interact mainly with the Tree Algorithm Component but they are triggered by actions in the GUI Component.
Component Interactions
To clarify the interaction between the components, several sequence diagrams have been put together.  These diagrams cover the largest operations encountered and the component interaction during that process.
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Figure 5.1‑1 Opening a New Program Tree

Loading an Existing Program Tree
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Figure 5.1‑2 Loading Program Tree

Saving a Program Tree
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Figure 5.1‑3 Saving a Program Tree

Exporting a Program Tree to Java Code
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Figure 5.1‑4 Exporting a Program Tree to Java Code

Cutting/Copying a Sub-tree
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Figure 5.1‑5 Cutting/Copying a Sub-Tree

Pasting a Sub-tree
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Figure 5.1‑6 Pasting a Sub-Tree

Pasting a Sub-tree Using the Clipboard
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Figure 5.1‑7 Pasting a Sub-Tree Using the Clipboard

5.2 Package Specifications

5.2.1 Package: tred.codegenerator

This package contains the base classes necessary for generating Java code for exportation.
5.2.2 Package: tred.codegenerator.java
This package contains the JavaCodeGenerator class which defines how to layout Java code for the code generator.
5.2.3 Package: tred.datastructures
This package contains the basic data types for the tree.  All node classes are defined here as well as the node shaping functions.  The following classes are contained in this package:
· ClassNode

· ClipBoard

· JavaProgNode

· MemberVarNode

· MethodNode

· Node

· NodeDefs

· NodeDisplayInfo

· PackageNode

· ShapeFunction

· Step
5.2.4 Package: tred.gui
This package contains all classes used in the GUI interface.  This package is the central package to the entire application.  All units tie together via this package.  The following classes are contained in this package:
· ClipboardDialog

· EditNodeDialog

· Point2D

· Rect

· TredDesktop

· TreeCellRenderer

· TreeDrawer

· TreeView
5.2.5 Package: tred.javaexport
This package contains the top-most class which controls exporting not just to code, but specifically to java code.  The only class inside of this package is JavaExporter.
5.2.6 Package: tred.xml
This package contains 2 classes which are used for loading and saving the intermediate XML file format (GRXL).  The 2 classes are XMLExport and XMLImport.
5.3 Database Specifications

Not applicable

5.4 Class Specifications

5.4.1 Classes in Package tred.codegenerator
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5.4.1.1 CodeClass

Represents the necessary metadata to generate a class in Java.

Table 5.4.1.1-1 CodeClass Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	CodeClass
	(String)
	Constructor.  Initializes members.
	

	getName
	String
	Gets the name of the class.
	

	setName
	String (String)
	Sets the name of the class.
	

	getFields
	CodeFieldCollection
	Gets the collection of fields contained in this class.
	

	getMethods
	CodeMethodCollection
	Gets the collection of methods contained in this class. 
	


5.4.1.2 CodeClassCollection

Holds a collection of classes.  Normally contained within a CodePackage.

5.4.1.3 CodeCompileUnit

Represents the packages and types in a single source file.

Table 5.4.1.3-1 CodeCompileUnit Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	CodeCompileUnit
	
	Constructor.  Initializes members.
	

	getPackages
	CodePackageCollection
	Gets the collection of packages in this source file.
	

	getReferences
	CodePackageReferenceCollection
	Gets the collection packages referenced by the types in this source file. 
	


5.4.1.4 CodeConstructor

Represents a constructor for a class.

Table 5.4.1.4-1 CodeConstructor Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	CodeConstructor
	
	Constructor.  Initializes members.
	

	getParameters
	CodeMethodParametersCollection
	Gets the collection of parameters for this constructor.
	


5.4.1.5 CodeConstructorCollection

Represents a collection of constructors for a CodeClass.
5.4.1.6 CodeDestructor

Represents a destructor for a class.

Table 5.4.1.6-1 CodeDestructor Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	CodeDestructor
	
	Constructor.  Initializes members.
	


5.4.1.7 CodeField

Represents a member field in a class.

Table 5.4.1.7-1 CodeField Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	CodeField
	(String, String)
	Constructor.  Initializes members.
	

	getName
	String
	Gets the name of the field.
	

	setName
	(String)
	Sets the name of the field.
	

	getType
	String
	Gets the type of the field.
	

	setType
	(String)
	Sets the type of the field.
	


5.4.1.8 CodeFieldCollection

Represents a collection of fields in a class.

5.4.1.9 CodeGenerator

Common interface for all CodeGenerators.

Table 5.4.1.9-1 CodeGenerator Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	Write
	(Writer, CodeCompileUnit)
	Writes a CodeCompileUnit to a Writer.
	


5.4.1.10 CodeMember

Represents common metadata for fields and methods in a class.

Table 5.4.1.10-1 CodeMember Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	CodeMember
	(int)
	Constructor.  Initializes members.
	

	getMemberAccess
	int
	Gets the access level of this member.
	

	setMemberAccess
	(int)
	Sets the access level of this member.
	


5.4.1.11 CodeMethod

Represents a method in a class.

Table 5.4.1.11-1 CodeMethod Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	CodeMethod
	()
	Constructor.  Initializes members.
	

	getName
	String
	Gets the name of the method.
	

	setName
	(String)
	Sets the name of the method.
	

	getType
	String
	Gets the type of the method.
	

	setType
	(String)
	Sets the type of the method.
	

	getParameters
	CodeMethodParameterCollection
	Gets the parameters of this method.
	


5.4.1.12 CodeMethodCollection

Represents a collection of methods in a class.

5.4.1.13 CodeMethodParameter

Represents parameters to methods in classes.

Table 5.4.1.13-1 CodeMethodParameter Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	CodeMethodParameter
	(int)
	Constructor.  Initializes members.
	

	getName
	String
	Gets the name of the parameter.
	

	setName
	(String)
	Sets the name of the parameter.
	

	getType
	String
	Gets the type of the parameter.
	

	setType
	(String)
	Sets the type of the parameter.
	


5.4.1.14 CodeMethodParameterCollection

Represents a collection of parameters on methods in a class.

5.4.1.15 CodePackage

Represents a package.

Table 5.4.1.15-1 CodePackage Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	CodePackage
	(String)
	Constructor.  Initializes members.
	

	getName
	String
	Gets the name of the package.
	

	setName
	(String)
	Sets the name of the package.
	

	getClasses
	CodeClassCollection
	Gets the collection of classes in this package.
	

	equals
	Boolean (Object)
	Determines if two packages are equal.
	


5.4.1.16 CodePackageCollection

Represents a collection of packages.

5.4.1.17 CodePackageReference

Represents references to other packages in a source file.

Table 5.4.1.17-1 CodePackageReference Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	CodePackageReference
	(String)
	Constructor.  Initializes members.
	

	getName
	String
	Gets the name of the package referenced.
	

	setName
	(String)
	Sets the name of the package referenced.
	


5.4.1.18 CodePackageReferenceCollection

Represents a collection of package references in a source file.

5.4.1.19 TypedAbstractCollection

Utility class to aid in the construction of type safe collections.

Table 5.4.1.19-1 TypedAbstractCollection Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	TypedAbstractCollection
	(Class)
	Constructor.  Initializes members.
	

	validateType
	(Object, Class)
	Ensures the object is of the proper class.
	


5.4.2 Classes in Package tred.codegenerator.java
5.4.2.1 JavaCodeGenerator

Takes a CodeCompileUnit and writes it as java code to the specified Writer. (Normally a FileWriter)

Table 5.4.2.1-1 JavaCodeGenerator Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	Write
	(Writer, CodeCompileUnit)
	Writes a CodeCompileUnit as java source to a Writer.
	

	writePackageReference
	(Writer, CodePackageReference)
	Writes a CodePackageReference as java source to a Writer.
	

	writePackage
	(Writer, CodePackage)
	Writes a CodePackage as java source to a Writer.
	

	writeClasss
	(Writer, CodeClasss)
	Writes a CodeClass as java source to a Writer.
	

	writeField
	(Writer, CodeField)
	Writes a CodeField as java source to a Writer.
	

	writeMethod
	(Writer, CodeMethod)
	Writes a CodeMethod as java source to a Writer.
	

	writeParameter
	(Writer, CodeParameter)
	Writes a CodeParameter as java source to a Writer.
	

	writeAccess
	String (int)
	Writes an access flag as a string.
	


5.4.3 Classes in Package tred.datastructures

  Class Diagram
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5.4.3.1 Node

The Node class is an abstract base class for all node classes to derive from.  It serves as a basis for the common data among all nodes, and maintains the parent-child-sibling relationships.  It also contains an instance of NodeDisplayInfo, which maintains the information necessary for displaying the node in the GUI.

Table 5.4.3.1-1 Node Class Interface
	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	Node
	None
	Constructor.  Initializes the member fields to null.
	

	InsertFirstChild
	(Node child)
	Inserts the node argument ‘child’ as the first child in this node’s subtree.
	

	InsertLastChild
	(Node child)
	Inserts the node argument ‘child’ as the last child in this node’s subtree.
	

	InsertUpperSibling
	(Node sib)
	Inserts the node argument ‘sib’ as the upper sibling to this node.  Calls the insert method of this node’s parent.
	

	InsertLowerSibling
	(Node sib)
	Inserts the node argument ‘sib’ as the lower sibling to this node.  Calls the insert method of this node’s parent.
	

	Cut
	None 
	Removes this node from its parent, and returns a reference to this node.
	

	GetNodeOrder
	None
	Returns the zero-based index of this node with respect to its siblings
	

	GetNodeDisplayInfo
	None
	Returns the NodeDisplayInfo object for this node.
	

	GetType
	None
	Returns an integer identifier that identifies the type of node this is (Package, Class, MemberVar, etc.)
	

	GetChildCnt
	None
	Returns the number of children this node has
	

	GetParent
	None
	Returns a reference to this node’s parent.
	

	GetChild
	(int idx)
	Returns a child at the specified index
	

	GetFirstChild
	None
	Retruns the first child of this node.
	

	GetLastChild
	None
	Returns the last child of this node.
	

	GetNode
	(int x, int y)
	Returns the node that lies on the point (x,y).  Useful for finding a selected node in the GUI.
	

	ReCalculateTree
	()
	Refactors the entire tree according to the tree spacing algorithm provided by Dr. Workman
	NodeDisplayInfo::ReCalulateTree()


5.4.3.2 JavaProgNode

This node represents a java program unit.  This is the root of a tree.  Each view will have only one instance of this object.  It will contain all other nodes in its sub-tree.

Table 5.4.3.2-1 JavaProgNode Class Interface
	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	JavaProgNode
	None
	Constructor.  Initializes members.
	

	Copy
	None
	Returns a duplicate of this node and its complete subtree
	NodeDisplayInfo::

ChangeLabel()


5.4.3.3 PackageNode

This node represents a java package.  

Table 5.4.3.3-1 PackageNode Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	PackageNode
	None
	Constructor.  Initializes members.
	

	Copy
	None
	Returns a duplicate of this node and its complete subtree
	NodeDisplayInfo::

ChangeLabel()


5.4.3.4 ClassNode

This node represents a java class.  It contains a field for the visibility specified for the class.

Table 5.4.3.4-1 ClassNode Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	ClassNode
	None
	Constructor.  Initializes members.
	

	Copy
	None
	Returns a duplicate of this node and its complete subtree
	NodeDisplayInfo::

ChangeLabel()

	ChangeVisibility
	(int newVis)
	Changes the visibility (public, protected, private) of this node.
	

	GetVisibility
	None
	Returns the visibility 
	


5.4.3.5 MethodNode

This node represents a java method.  It contains fields for its visibility and return type.

Table 5.4.3.5-1 MethodNode Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	MethodNode
	None
	Constructor.  Initializes members.
	

	Copy
	None
	Returns a duplicate of this node and its complete subtree
	NodeDisplayInfo::

ChangeLabel()

	ChangeVisibility
	(int newVis)
	Changes the visibility (public, protected, private) of this node.
	

	ChangeReturnType
	(String newRet)
	Changes the return type of this node.
	

	GetVisibility
	None
	Returns the visibility 
	

	GetReturnType
	()
	Returns the String representation of the return type
	


5.4.3.6 MemberVarNode

This node represents a java member variable belonging to a class.  It contains fields for its visibility and type.

Table 5.4.3.6-1 MemberVarNode Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	MemberVarNode
	None
	Constructor.  Initializes members.
	

	Copy
	None
	Returns a duplicate of this node and its complete subtree
	NodeDisplayInfo::

ChangeLabel()

	ChangeVisibility
	(int newVis)
	Changes the visibility (public, protected, private) of this node.
	

	ChangeMemberVarType
	(String newRet)
	Changes the variable type of this node.
	

	GetVisibility
	None
	Returns the visibility 
	

	GetMemberVarType
	()
	Returns the String representation of the variable type
	


5.4.3.7 NodeDisplayInfo

This class contains all of the information necessary for displaying a node in the GUI.  This includes its pixel coordinates for origin, width, and height of the node.  It also manages spacing the tree according to the tree spacing algorithm provided by Dr. Workman.

Table 5.4.3.7-1 NodeDisplayInfo Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	NodeDisplayInfo
	(Node theNode)
	Constructor.  Sets argument ‘theNode’ as the node this displayinfo is linked to.
	

	ChangeOrigin
	(int x,int y)
	Changes the origin values of this node.
	

	ChangeLabel
	(String label)
	Changes the label displayed in the GUI for this node.
	

	CollapseChildren
	None
	Sets this node as having ‘collapsed’ children in the GUI.
	

	ExpandChildren
	None
	Reverses the changes made by ‘CollapseChildren()’
	

	Select
	None
	Sets this node as ‘selected’ in the GUI.
	

	DeSelect
	None
	Reverses the changes made by ‘Select()’
	

	GetOrigin
	None
	Returns a Point2D object that represents the upper left corner of this node.
	

	GetNodeWidth
	None
	Returns the pixel width of this node.
	

	GetNodeHeight
	None
	Returns the pixel height of this node.
	

	GetBoundingRect
	None
	Returns a Rect object that defines the bounding rectangle of this node and its subtree.  Used by the clipboard to allocate enough space to display the subtree.
	

	GetLabel
	None
	Returns the label displayed in the GUI.
	

	IsCollapsed
	None
	Returns whether or not this node is ‘collapsed’ in the GUI.
	

	IsSelected
	None
	Returns whether or not this node is selected in the GUI.
	


5.4.4 Classes in Package tred.gui 

5.4.4.1 ClipboardDialog

This class is the GUI panel that displays on the screen to show the contents of the Clipboard.  It is a extension of the Java Swing class JDialog.
Table 5.4.4.1-1 ClipboardDialog Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	ClipboardDialog
	None
	Constructor: sets the default values for the content Panel
	createTreeList()
createButtonPane()

	createButtonPane()
	JComponent
	Creates the Button Pane in the clipboard dialog
	

	createTreeList()
	JComponent
	Creates the TreeList that contains the clipboard
	

	actionPerformed()
	None
	The action listening method for this JDialog ActionListener, it take the appropriate path for each action of a GUI element.
	


5.4.4.2 EditNodeDialog

This class is the GUI panel that displays on the screen to show Edit Node dialog, it is used to edit node information as well as insert new Nodes. It creates the new nodes when the window is opened for “insertion”, and edits nodes when the window is opened for “editing”. 

Table 5.4.4.2-1 EditNodeDialog Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	EditNodeDialog
	None
	Constructor: sets the default values for the content Panel
	FillInfo()
MakePanel();

	FillInfo
	None
	Fills the various text and buttons with the data for the current Node
	

	MakePanel
	JPanel
	Creates the GUI elements that compose the EditNode Window. Dynamicly changes based on Node Type
	

	getNode
	Node
	Returns the private member variable m_tempNode, (used for insertion)
	

	actionPerformed()
	None
	The action listening method for this JDialog ActionListener, it take the appropriate path for each action of a GUI element.
	


5.4.4.3 Point2D

A Simple data structure used to mark a point in 2-Dimensional Space. 

Table 5.4.4.3-1 Point2D Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	Point2D
	None
	Constructor: sets X and Y position of the point
	


5.4.4.4 Rect

This class represents a 2-dimensional rectangle. It is used to describe the dimensional bounds of a given node in the tree. 
Table 5.4.4.4-1 Rect Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	Rect
	None
	Constructor: sets the dimensional values for the rectangle.
	

	ChangeOrigin
	None
	Takes a Point2D and set the rect’s Orgin to the coordinates of the point.
	

	ChangeWidth
	None
	Changes the width of the rectangle. 
	

	ChangeHeight
	None
	Changes the Height of the rectangle.
	

	GetOrigin

	None
	Returns the rect Origin.
	

	GetWidth
	None
	Returns the rect Width.
	

	GetHeight
	None
	Returns the rect Height.
	


5.4.4.5 TredDesktop
This class extends the Java Swing GUI Class JFrame implements the standard ActionListener used for GUI action capture. It is used as the main desktop GUI element, it handles all of the main GUI functionality such as the Edit and File menu and manages of the multiple treeView windows. 
Table 5.4.4.5-1 TredDesktop Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	TredDesktop
	None
	Constructor: Sets default locations of windows and calls Initialization methods for the various elements of the GUI.
	initGUI()

	initGUI
	None
	Creates every GUI element that is visible other than the treeView windows. 
	CreateMenuBar()

	CreateMenuBar
	None
	Creates the File menu.
	CreateEditMenu

	CreateEditMenu
	None
	Dynamically creates the Edit Menu and the right click pop-up menu based on the current node selected.
	

	addTree
	None
	Creates a new tree window with the tree that is passed.
	

	getActiveTreeView
	TreeView
	Returns the Currently active tree window.
	

	actionPerformed()
	None
	The action listening method for this JDialog ActionListener, it take the appropriate path for each action of a GUI element.
	


5.4.4.6 TreeCellRenderer 

This class extends the Java Swing GUI Class extends JPanel implements ListCellRenderer. It is used to create the “Paste from Clipboard” list that displays the contents on the clipboard.

Table 5.4.4.6-1 TreeCellRenderer Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	getListCellRendererComponent
	None
	Returns the  TreeCellRenderer Fully rendered.
	initGUI()

	paintComponent
	None
	Draws each tree in the clipboard  
	


5.4.4.7 TreeDrawer

This class Draws Trees. It takes in a graphics object and a root node and Draws a tree onto the given Java Graphics Object. No calculations or changes are performed, it simply draws. 
Table 5.4.4.7-1 TreeDrawer Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	DrawTree
	None
	Recursively draws the tree from the root node. 
	DrawNode

	DrawNode
	None
	Draws the node text.  
	DrawGlyph

	DrawGlyph
	None
	Draws the “Node Type” Glyph around the text of the Node.
	

	DrawLine
	None
	Draws a line between two 2D points.
	

	DrawText
	None
	Draws text at a given 2d point
	

	DrawCollapsedIndicator
	None
	Draws the Collapsed Tree Indicator.
	


5.4.4.8 TreeView

This class extends the Java Swing class JInternalFrame.  Each Tree view is associated with a java Tree, any actions taken on the tree are done graphically through the TreeView.  The TreeViews are the child windows of the TredDesktop. 

Table 5.4.4.8-1 TreeView Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	TreeView
	None
	Constructor: Sets the default member variables.  
	initComponents

	initComponents
	None
	Initializes the GUI components, including the drawing panel and scroll bars.
	

	getselectedNode
	Node
	Returns the node that is currently selected
	


5.4.5 Classes in Package tred.javaexport

5.4.5.1 JavaExporter

Represents the necessary metadata to generate a class in Java.

Table 5.4.5.1-1 JavaExporter Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	Export
	(String, JavaProgNode)
	Exports a JavaProgNode as source code in the given directory.
	

	ReadPackages
	(Node)
	Reads nodes representing packages.
	

	ReadClasses
	(Node, CodePackage)
	Reads nodes representing classes and adds them to the CodePackage.
	

	ReadMembers
	(Node, CodeClass)
	Reads nodes representing class members and adds them to the CodeClass.
	


5.4.6 Classes in Package tred.xml 

  Class Diagram
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5.4.6.1 XMLExport

The XMLExport class is the class which exports the Node data (in the form of the tree) out to an intermediate XML file format known as the GRXL file format.  This is a common graph format that is used outside of this project as well.

Table 5.4.6.1-1 XMLExport Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	XMLExport
	None
	Constructor.
	None

	PrintHeader
	(BufferedWriter bufWrite)
	Prints the GRXL header information to an already open file via the BufferedWriter interface
	None

	PrintFooter
	(BufferedWriter bufWrite, String filename)
	Prints the GRXL footer information to an already open file via the BufferedWriter interface.
	None

	PrintChildrenNodes
	(BuffferedWriter bufWrite, Node nd)
	Recursive method used to output a nodes children and the edges connecting those children to the node itself.
	Node::GetChildCnt

Node::GetChild

Node::GetDisplayInfo

Node::GetType

DisplayInfo::GetOrigin

DisplayInfo::GetLabel

ClassNode::GetVisibiltyType

MethodNode::GetVisibilityType

MethodNode::GetReturnType

MemberVarNode:GetVisibilityType

MemberVarNode::GetMemberVarType



	PrintTreeNodeInfo
	(BufferedWriter bufWrite, JavaProgNode programBase)
	Prints out the XML data for the top program node and it’s children.
	Node::GetChildCnt

Node::GetChild

Node::GetDisplayInfo

Node::GetType

DisplayInfo::GetOrigin

DisplayInfo::GetLabel



	FileExists
	(String directory, String filename)
	Checks to see if a file of the appropriate name exists in the given directory.
	None

	ExportFile
	(String directory, String filename, JavaProgNode programBase)
	Opens the file for exporting and exports it.
	None


5.4.6.2 XMLImport

The XMLImport class is the class which imports the Node data (in the form of the tree) from an intermediate XML file format known as the GRXL file format.  This is a common graph format that is used outside of this project as well.

Table 5.4.6.2-1 XMLImport Class Interface

	Method 
Name
	Profile/
Signature
	Functional Description
	Methods Called
(Other Classes)

	XMLImport
	()
	Constructor
	None

	startDocument
	()
	Function called by Xerces XML parser when a document is started.
	None

	startElement
	(String uri, String local, String raw, Attributes attrs)
	Function called by Xerces XML parser when an element is encountered.
	Constructors on all node types
Node::GetDisplayInfo

DisplayInfo::ChangeLabel

DisplayInfo::ChangeID

DisplayInfo::ChangeOrigin

ClassNode::ChangeVisibility

MethodNode::ChangeVisibility

MethodNdoe::ChangeReturnType
MemberVarNode::ChangeVisibility

MemberVarNdoe::ChangeMemberVarType

	endElement
	(String uri, String local, String raw)
	Function called by Xerces XML parser when an element is finished being defined in the XML file.
	Node::GetDisplayInfo

Node::InsertLastChild
DisplayInfo::GetID

DisplayInfo::GetOrigin

	characters
	(char ch[], int start, int len)
	Function called by Xerces XML parser when an unknown character sequence is encountered.
	None

	ImportFile
	(String directory, String filename)
	Function that imports an XML file using the Xerces XML parser and creates a Java Program Tree.
	None

	GetCreatedTree
	()
	Get the tree created during the import process.
	None


6 Implementation Summary

Unfortunately, due to time constraints, we did not completely finish the project.  Looking at the time estimates calculated for the final, it’s easy to see why.  Approximately over 600 hours worth of work are required to fully complete the project based on my estimations using Schach’s chart data.  Currently, we’ve only spent about 203 hours developing the project this far.  Basically it would require about 3 semesters worth of work total.

Currently, users can exploit the majority of required functionality.  Users can Add, Edit, Cut/Copy and Paste program element nodes inside of a Java Program tree.  They can also Save and Load trees that they have created.  In addition, users can also choose to export the Java Program tree as actual Java source code.  

Unfortunately, due to time constraints, we were unable to finish the following things:

a) Nodes are not restricted in their placement during insert, edit, or paste operations.

b) Because of the above statement, if a tree isn't currently programmatically correct, it will not export properly compilable Java code.

c) Verification on Linux was never completed due to our only Linux machine deciding to fail booting.

d) There is a problem where in large trees random nodes do not draw at all.  They are there because if you copy the parent and paste it in another location, the node that didn't appear before now appears.

e) The saved/loaded GRXL files MUST be saved into the dat/ directory or another directory containing the grxl.dtd file.  This is a limitation on the way we use the XML parser data.

f) Certain portions of the code may not be as clean (or properly OO) as they could be due to delays in integration.

Setup information for Developers:
Currently, the application can be developed on either a Windows XP system or an Apple Macintosh running OS X Panther.  Before beginning, developers should have about 400 MB of RAM available on their system to install all tools and source.  If just the source, library, and data directories are needed (no tools directory) then only about 100 MB should be sufficient (that’s after both JRE and Eclipse have been installed). Developers must then install a Java Software Development Kit which will be used to interpret and run the program.  The Java SDK used by all initial developers was 1.4.2-06.  It is included on the CD for Windows XP and Linux.  In addition to the Java SDK, developers must then install Eclipse, which is an Integrated Development Environment (IDE).  We used Eclipse SDK version 3.0.1.  It is also included on the CD for Windows XP, Mac OS X, and Linux.  Eclipse is installed on most systems by simply uncompressing the compressed file and running the executable in the Eclipse directory.

To enable Eclipse for development:

1) Start up Eclipse

2) Create a new project

a) “File” -> “New”-> “Project…”

b) Choose “Java Project” and type in tred as the project name and click “Finish”.

c) Next, right click on the Project in the “Package Explorer” and choose “Import”.

d) Choose “File System” and click “Ok”

e) In the “From directory:” box, enter the directory of the src folder found on the CD.

f) Go into the src/tred directory in the dialog box and choose all the code directories and click “Finish”.

3) Change the preferences to include the appropriate JRE.

a) Menu “Window” -> Preferences.

b) Select “Java” and then “Installed JREs”.

c) Select the JRE from the SDK that you installed.

d) Activate the JRE with the checkbox on the left.

e) Highlight the JRE and choose “Edit”.

f) Uncheck the “Use default system libraries”.

g) Click “Add External JARs” and navigate to the libs/xerces-2-6-2/ directory on the CD and add all the JARs in that directory.

h) Click “OK” on the External JAR dialog.

i) Click “OK” on the JRE dialog.

4) Change the preferences to include Xerces in the class path.

a) Menu “Window” -> Preferences

b) Select “Java” and then “Build Path” and then “Classpath Variables”

c) Click “New” and add the “Name” of Xerces and the path to the libs/xerces-2-6-2 directory on the CD.

d) Click “OK” on the “New Variable Entry” dialog box.

e) Click OK on the Classpath Variable Dialog

5) To use Eclipse further, consult the Eclipse documentation.

Setup information for End Users/Testers:
To run TRED as an end-user, the entire directory tree should be copied as is from the CD.  Users should then install a Java Run-time Environment (JRE) for using to run the Java application.  The developers of this project used 1.4.2-06, but any JRE after that version should be functional as well.  For users running Windows XP, simply run the batch file “tred.bat” found in the /bin directory on the CD.   For Mac and Linux users, simply run the “tred.sh” shell script also located in the /bin directory on the CD.  The application should come up with no other problems.
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